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CHAPTER 1 EMAIL CONCEPTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Email provides a great way of communicating with friends, 
colleagues, business associates and the like. But with email comes 
certain responsibilities such as knowing how to protect yourself and 
others from viruses, understanding etiquette, dealing with spam and 
more. 

In this session you will: 

 gain an overview of how email works 

 gain an understanding of email addresses 

 gain an understanding of the benefits of email 

 gain an understanding of general email etiquette 

 gain an understanding of emails and viruses. 
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HOW EMAIL WORKS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Email is short for electronic mail and refers to a 
message sent from one computer to another. The 
computers may be in the same building and 
linked via a local network, or they may be some 

distance apart and connected via the Internet and 
various telephone and communication systems. 

Email Application 

To send email from your computer you will need an email application (this is sometimes known as 
an email client). This application allows you to compose and send emails to other people, and to 
receive emails.  

While there are a number of email applications on the market, the two most common are Microsoft 
Outlook which is supplied with Microsoft Office, and Windows Mail which is available as a download 
from Windows 7. 

This software needs to be installed on your computer. 

Email Server 

While an email client takes care of the business of writing and reading emails, it is the job of an 
email server to ensure that email is dispatched to the correct location and recipients.  

Using normal mail (sometimes known as snail-mail) as an analogy, an email server is a bit like a 
post office. It takes the emails that you have created and sends them through the appropriate 
electronic pathways to the intended recipients. It also collects email messages that people are 
sending to you and it then delivers these emails to the email client on your computer. 

If you send email messages to people in your company, these messages will generally only pass 
through one email server – the one that looks after the internal email in your business. This will most 
likely be something like Microsoft Exchange Server. When you send an email to a colleague outside 
your company, that email is sent to the server and the server then passes it to the email client on 
your colleague’s computer – this is done in an instant. 

When you send email via the Internet, however, the business of email servers becomes more 
complicated. Generally, it is your Internet Service Provider (ISP) who handles your Internet email, 
and, given the volume of mail they handle, they will have quite a few computers to do this. With 
Internet email there are separate servers that handle outgoing email (email that you are sending) 
and incoming email (email that someone is sending to you). Outgoing email is handled by the SMTP 
server (SMTP stands for Simple Mail Transfer Protocol), while incoming email is handled by the 
POP server (POP stands for Post Office Protocol). 

To be able to send and receive emails via the Internet, computers need to be connected to both an 
SMTP and POP server. Therefore, when you send an email to someone via the Internet, it leaves 
your email client and goes to your ISP’s SMTP server. From here it is sent to the recipient’s POP 
server, which then passes it to your recipient’s email client. Understanding that there is this alphabet 
soup of connections will help you to appreciate why emails sometimes get lost in cyberspace! 

Email Account 

To use an email server you will need to have an email account. An email account is a bit like having 
a post box at the local post office. An account is normally made up of two components: a user name 
which identifies you to other people and the system, and a password which ensures that other 
people can’t access your mail. 

With a proper user name (sometimes known as a user ID) and a password, your computer can 
connect to an email server. 
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EMAIL ADDRESSES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Just like your street address identifies where you 
live, you’ll need to have an email address so that 
other people can send emails to you. Unlike 
street addresses, however, email addresses 

comprise only a single line of characters. And the 
characters, once you understand what they mean, 
can tell you a great deal about the owner of the 
email address. 

Identifying Email Addresses 

An email address is a unique address on the Internet that allows people to send email messages to 
you. 

An email address is written in a special way as follows: 

username@domainname.topleveldomain.country 

An example of an email address might be: 

john@watsoniapublishing.com.au 

The funny symbol in the middle (@) is known as an at symbol. If read aloud, the sample email 
address above would be spoken as “ john at watsonia publishing dot com dot au”.  

Note that email addresses are not case sensitive. But, in most locations the standard convention is 
to write email addresses in lowercase. 

The User Name 

The user name is used to identify the name of the owner of the email address. It is usually 
descriptive and pretty close to the actual name of the person. It could be just the first name, just the 
last name, both first and last names, first name plus the first letter of the person’s last name, and so 
on. For example, John Smith may appear as: ‘john’, ‘smith’, ‘johnsmith’, ‘johns’, ‘jsmith’ and so on. 

While there are no rules governing how the user name should appear, some workplaces have 
established a particular style that they want you to use. Your system administrator at work will 
probably set up your email address for you following company practice. 

The Domain Name 

The domain name helps the Internet identify the location of the email server that is hosting the 
email account. Sometimes, the domain name reflects the name of the Internet Service Provider (e.g. 
johns@bigpond.com) and other times it might be the name of your workplace (e.g. 
john@watsoniapublishing.com.au). 

The Top Level Domain 

The top level domain normally consists of three letters and identifies the type of organisation 
associated with the host’s name. Examples of common top level domains include: 

.com private or public company 

.gov government department or organisation 

.edu educational institution 

.net networks usually reserved for Internet service providers  

.org non-commercial organisations  

The Country Identifier 

Email addresses outside the United States are usually identified with an additional two letters at the 
end. Some of the more common ones are au for Australia, uk for United Kingdom, nz for New 
Zealand, de for Germany, fr for France, and so on. 
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THE BENEFITS OF EMAIL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There is little doubt that email has provided the 
greatest communication revolution since the 
invention of the printing press. With many people 
email has all but replaced the use of regular mail, 

and billions of messages are sent every day. Email 
presents enormous benefits and advantages over 
traditional mail. Some of these are presented 
below. 

It’s Fast 

With emails you can send a message to someone on the other side of the world literally within 
seconds. It is possible, therefore, to have an email ‘conversation’ where you are sending short 
messages back and forth with someone next door, in the next state or territory, or even on another 
continent. 

It’s Cheap 

The cost of sending an email is normally made up of the time you spend online to send it. If you’re 
sending lots of messages it makes sense to write them at a time when the computer is not 
connected to the Internet – this is technically known as offline. As you write these messages they 
can be ‘Sent’ in your email program – if the computer is offline the email program will keep these 
messages in a special Outbox until the computer is online. The messages will then be sent almost 
instantly. The cost of sending email therefore is usually much less than the cost of postage or even 
sending a fax. 

It’s Convenient – for lots of reasons 

With email you can conveniently communicate with people who are either in different time zones, or 
who work and live differently to you. For example, you might send a letter to Aunty Flo at the time 
you work best (around 11:30 pm at night) knowing full well that Aunty Flo, who normally retires by 
8:00 pm, will be able to log onto her computer first thing in the morning to read your message. Or 
you might communicate with someone in a different country, even though it is past midnight in that 
country, and know that the recipient will open and read your message as soon as they log onto their 
computer. 

Email also prevents the game of telephone tag – where you ring someone but they are unavailable, 
and they ring you back when you are unavailable, so you return their call and they are again 
unavailable, and so on. With email you compose and send your message when it is convenient for 
you. Your recipient will open, read and respond to your message when it is convenient for them.  

It’s a fact that most busy people hate to get interrupted by phone calls. However, most busy people 
make a time to access and read their email. So with email it is much easier to get in touch with busy 
people. 

You can also use email from a number of places. For example, let’s say you’re on a world trip. You 
can pop into an Internet café almost anywhere in the world and use one of the Web-based email 
services to send an email home to your friends and loved ones. You don’t need to worry about 
stamps, local postage rates, or any of the other issues associated with mailing from another place. 

It’s Educational – maybe 

Email is a form of communication done using the written word. In these times of television saturation 
there is evidence to suggest that email is bringing people back to writing and is thus increasing the 
levels of literacy in the community. The argument here is that email has brought back the art of letter 
writing, even if it is in a form that this is shortened, and lighter. 

It Provides Access 

Email is providing access to almost anyone in the world. In theory it is possible to send an email to 
the President of the United States, your favourite movie star or football player, and even Father 
Christmas. However, there is no guarantee that they will open and read your email. 

It Provides A Record 

Since outgoing messages are kept in the Sent box you’ll always have a record of interactions with 
people with whom you have communicated. Although, if you are into major crime this may turn out to 
be a bad thing! 
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EMAIL ETIQUETTE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you write and send an email there is a 
chance that it will live forever – a sobering 
thought when you sit down and really think about 
it. Therefore you should adopt courteous and 

polite habits when writing your email messages. 
Quite a few guidelines have now been developed 
to help you be a good email citizen. Some of these 
are listed below. 

Short Is Sweet 

Reading text on the screen is harder and (arguably) more hazardous than reading on paper. Keep 
your emails short, sweet and to the point and your recipients will love you more. 

Bad Spellers Look Like Dills 

When you have composed your message spend a bit more time using the spell checker to check the 
spelling. Then re-read the message and ensure that the spell checker has done its job. You’d be 
amazed at how many online resumes have been sent straight to the Deleted Items folder because 
of bad and negligent spelling! 

Make The Subject Line Meaningful 

There’s nothing more frustrating than receiving a message with a subject that contains ‘Hi’. What 
does this mean? Is it going to waste my time? Always put meaningful text in the subject line of a 
message, such as “How about lunch?”, “Sales Figures for June”, and so on. 

Watch What You Say 

The way we interact with one another is done through a number of ways – we hear what is said and 
listen for inflections, and we see what people are doing with their eyes. In an email you can only 
really read what is being said – how do you know if it is serious or written in jest? When you 
compose an email, don’t try to be too smart or cute, or you may find that your reader totally 
misinterprets what you are saying. 

Avoid Flaming 

Flaming is the act of telling somebody off using an email – and it should NEVER be done. If you 
have a gripe with someone, contact them over the phone or face to face, but never through an email. 
The big danger with email is that it can be read over and over again. If you use email to dress down 
someone they will read it once, then again, and again until they become enraged. And then they 
may flame you with an equally or even more vitriolic email. And guess what you’ll do – yep, respond 
with yet another. 

Don’t SHOUT 

In email shouting is done by using capital letters – and it has become almost as obnoxious to receive 
an email written in capital letters as it has for someone to come up and shout something in your ear. 
Don’t use capital letters (except in the proper literary way for sentence starts, names, and the like) 
unless you specifically mean to shout something and be offensive. 

Check The Attachments You Send For Viruses 

Yeah, yeah, your recipient should really be responsible for this. But imagine how you’d feel if the 
potential customer you are trying to woo rings you up and says the email you sent had a virus. 
Wouldn’t it be more professional and nice to be able to reply, “Gee, that’s strange. I carefully 
checked and scanned the attachment(s) for viruses before I sent it. Are you sure the virus was from 
my email?” 

Protect The Privacy of Others 

When you want to send an email to a group of people you enclose their email addresses either in 
the To or the Cc fields. The problem here is that all of the recipients know exactly who else received 
this message, and, in many cases the address of each recipient is provided to all of the other 
recipients. If you are sending a message to many people and it is not necessary for the recipients to 
know who else received the message, put their addresses in the Bcc field and put your own address 
in the To field – Outlook needs to have at least one address in the To field. 
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EMAILS AND VIRUSES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A virus is a computer program that somehow or 
other manages to attach itself to an application 
on your computer with the intent of causing some 
mischief. Like human viruses the results can 

range from virtually nothing at all, right through to, 
well, the death of your computer. In the past 
viruses have been passed along on floppy disks, 
but today the main transfer vehicle is email. 

Types of Viruses 

There are many types of viruses, the most common being: boot sector viruses that infect the start 
up program of your computer; program viruses that infect software programs on your computer; 
and macro viruses that infect macro programs written in Microsoft Word or Microsoft Excel. Within 
these types there are two broad categories: Trojans, which appear hidden and perform their nasty 
deeds without you noticing; and Worms which remain invisible, consume the resources on your 
computer, and appear only as your computer begins to slow down and choke up. 

How Do You Get A Virus? 

At the present time a virus is a program and it can only really be transmitted through other programs. 
Generally, there are three ways that a virus can get itself onto your computer: 

1. From an infected disk or Flash drive that you place into the CD or USB drive. The virus here 
is transmitted usually through a hidden program that automatically loads when the disk is 
inserted. 

2. From an attachment you receive via email and then (usually) double-click to open. Note, 
however, that some email viruses will launch without even being opened – they will launch 
when you view the infected message in the preview pane of your email software!)  

The attachment may itself be a program or something like a letter that has a macro 
(program) in it that has been designed to automatically start as soon as the letter is opened. 

3. From a software program that you download from a website. The software program (usually 
from a dubious source) will contain the virus which will infect your computer when the 
software is run. 

How Do You Prevent Viruses From Infecting Your Computer? 

The best way to protect your computer is by not having it connected to the Internet or any form of 
network, and to never place a disk into the CD drive. However, this is extremely impractical. 
Because you need to be connected in the real world, the best you can hope for is to minimise your 
risk of being infected.  

To minimise the chances of being infected: 

 Install, use and constantly update a good anti-virus software application on your computer, 
such as Nortons, Symantec, and the like. 

 Install a firewall – this is special software that protects your computer from unwarranted 
entry from the Internet. Your company may already have a firewall set up. 

 Set up the anti-virus software so that it runs in memory – this ensures that it is vigilantly and 
constantly checking incoming files for possible dangers and threats. 

 Always use the anti-virus software to scan email attachments and NEVER open an 
attachment until it has been scanned and cleared. 

 Never download software from dubious sources, such as screensavers, icons, freeware, and 
so on. 

Note: At the time of writing it is not possible to get a virus by opening up a standard text-based email 
message. Viruses are only transmitted through email attachments. However, do not click on links in 
suspicious emails as these may take you to sites where you could get infected. With the 
sophistication of hackers and virus writers increasing daily, ensure that you check all of your 
incoming email very carefully! 
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CHAPTER 2 OUTLOOK 2010 BASICS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Outlook 2010 is a time and information management program that 
helps you to manage your day-to-day tasks and information quickly 
and effectively. 

This chapter covers some of the basic principles and navigation 
methods to help you get up and running with Outlook 2010 as 
quickly as possible. 

In this session you will: 

 gain an overview of what Outlook 2010 is used for 

 learn how to start Outlook 

 gain an overview of the common Outlook 2010 screen 
elements 

 learn how to use the Ribbon 

 gain an understanding of Backstage View in Microsoft 
Outlook 

 gain an understanding of the Quick Access Toolbar 

 learn how to navigate to specific features of Outlook 

 learn how to customise the Navigation pane 

 learn how to work with the To-Do Bar to help manage 
your time and priorities 

 gain an overview of the Mail screen 

 gain an overview of the Calendar screen 

 gain an overview of the Contacts screen 

 gain an overview of the Tasks screen 

 gain an overview of the Notes screen 

 learn how to close Outlook. 

INFOCUS 
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UNDERSTANDING OUTLOOK 2010 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Microsoft Outlook is designed to help you 
manage the way that you organise the day-to-day 
aspects of your business and personal life and 
the way that you interact with other computer 

users. You can use it to communicate with others, 
to keep track of your appointments and meetings, 
and to manage the contact details of individuals or 
businesses.  

Key Features of Outlook 2010 

Microsoft Outlook is both a personal information manager and electronic messaging system 
rolled into one. Outlook can be used to keep track of your diary, hold the contact details of your 
customers, suppliers and associates, schedule meetings, send messages, and generally keep track 
of things you have to do. 

To do this, Outlook provides you with five main tools. These are Mail, Calendar, Contacts, Tasks 
and Notes. These tools work together, as well as independently, to provide you with a useful 
package known as Microsoft Office Outlook 2010. 

 

Mail The Mail tool allows you to manage electronic mail. You use this aspect of 
Outlook to send messages and to receive them from others. These messages 
can either be ones sent from within your own organisation (internal email) or 
externally using the Internet. 

 

Calendar The Calendar tool provides you with an electronic diary which can also be 
used to schedule and plan meetings with other people connected to your 
computer system or over the Internet. 

 

Contacts The Contacts tool allows you to manage business and personal contacts by 
recording the names, addresses, telephone numbers, and email details of 
people such as colleagues, customers, suppliers, friends, relatives, and the 
like. 

 

Tasks The Tasks tool provides you with a To-Do list. You can also use it to prioritise 
tasks and to delegate them to others and track how many of them have been 
completed. 

 
Notes The Notes tool allows you to type memory jogging notes into your computer so 

that you can refer to them again later. 

There are several other subsidiary tools in Outlook that you may find useful. These include the 
Journal which automatically records actions you choose that relate to specific contacts and places 
those actions in a timeline view, and Outlook Today which allows you to see what messages you 
have, what you need to do, plus other important information in one handy screen. 

How Outlook Is Used 

Outlook can be opened and used as required, or it can be left open and operating behind the scenes 
while you are working with other applications. Generally, it is left open so that new mail and 
invitations can be received at any time. Outlook can then notify you even if you are working with 
another application. 

Since it is designed to allow you to communicate with other people, Outlook will operate on both 
your network and Internet connections. 
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STARTING OUTLOOK 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before you begin, ensure that your 
computer is switched on and that the 
Windows desktop is displayed on 
your screen… 


Click on the Windows Start 
button at the bottom left-hand 
corner of the screen to display 
the menu 

It’s a round button with the 
Windows logo... 


Click on All Programs 


Click on Microsoft Office 


Click on Microsoft Office 
Outlook 2010 

After a few moments the Inbox 
in the Mail feature will open in 
Outlook 2010 

 

For Your Reference… 

To start Microsoft Outlook: 

1. Click on the Windows Start button 

2. Click on All Programs 

3. Click on Microsoft Office 

4. Click on Microsoft Office Outlook 2010 

Handy to Know… 

 You can also start Outlook by double-clicking 
on an Outlook shortcut. 

1 

2 

To send an email message or invite staff to a 
meeting, the first thing that you need to do is to 
start Microsoft Outlook. As a standard software 
application, how Microsoft Outlook is started is 

largely determined by Windows. For example, it 
can be started from the Windows Start menu or 

from a shortcut on the desktop or taskbar. 

4 
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COMMON OUTLOOK 2010 SCREEN ELEMENTS 
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Outlook can do so many different things for you 
and as a consequence its screen is probably the 
most interesting of all. No two Outlook 2010 
screens will ever appear alike because of how 

Outlook works, what data it receives, and what 
functions a person prefers to use regularly. 
Nevertheless, your screen will have many of the 
key features that are shown below. 


The Title bar displays the name of the feature that you are currently using, followed by 
‘Microsoft Outlook’. 


The File tab is used to access the Backstage view which contains settings that are not 
directly related to creating or managing Outlook items such as Print and Save commands, 
and account management functions such as opening calendars and importing files. Outlook 
Options are also available so that you can set your working preferences and options for 
Outlook 2010. 


The Ribbon is the tabbed band that appears across the top of the window. It is the control 
centre of Outlook 2010. Instead of menus, you use the tabs on the Ribbon to access the 
commands that have been categorised into groups. The commands include galleries of 
formatting options that you can select from, such as the Quick Steps gallery shown here. 


The Navigation pane provides a quick way of switching between the various Outlook 
features such as Mail, Calendar, Contacts, and so on. 


The Status bar indicates what is going on in Outlook at the present moment. It also changes 
depending upon the feature you are using and the tool that you are working with. 


The resizing buttons allow you to minimise  (make smallest), maximise  (make 
largest), restore down  (return to the size between minimise and maximise), and close 

 the application window. 


The To-Do bar integrates your follow-up messages, tasks and appointments in one central 
location. 

 

 

1 
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USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Before starting this exercise ensure 
Outlook has started… 


Examine the groups on the 
Home tab 

These contain the most 
commonly used commands 
relevant to the Outlook feature 
that you are currently using 
(for example, Inbox in Mail in 
this case)... 


Click on the View tab 

The commands on this tab are 
used to change how the 
information will display in the 
window... 


Click on Change View  in 
the Current View group to 
display the View gallery 

This includes three viewing 
options as well as three menu 
options at the bottom of the 
list... 


Click on each of the tabs and 
examine the commands 

Some of these open dialog 
boxes... 


On the Folder tab, click on 
New Search Folder in the 
New group to open the New 
Search Folder dialog box 


Click on [Cancel] then click on 
the Home tab 

 

For Your Reference… 

To use the Ribbon: 

1. Click on a tab to display the commands 

2. Click on a tool to activate a command, 
display a gallery or display a dialog box 

Handy to Know… 

 Clicking on some commands will open a new 
window with its own ribbon and tabs specific 
to the function. For example, when you click 
on New E-mail  in the New group on the 
Home tab, a new untitled message window 
will open complete with tabs and commands 
relevant to creating a new message. 

 

1 

2 

The Ribbon is the command centre for Outlook. 
It provides a series of commands organised into 
groups that are placed on relevant tabs. Tabs 
are activated by clicking on their name to display 

the command groups. Commands are activated by 
clicking on a button, tool or gallery option. 
Everything you could possibly want to do in Outlook 
will be found somewhere on this Ribbon. 
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UNDERSTANDING THE BACKSTAGE VIEW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Ribbon lets you work directly on or with an 
Outlook item – you can create an email, format it, 
send it, and much more. The Backstage view, 
which is accessed using the File tab, provides 

commands that are not directly related to creating 
or managing an Outlook item. For example, you 
can access account details, clean your mailbox, 
save attachments and configure other settings. 

The Backstage View 

The File tab on the Ribbon is not 
a normal tab – as you can tell by 
the fact that it is coloured. Clicking 
on the File tab launches a mini-
program within Microsoft Outlook 
known as Backstage View. 
Backstage, as it’s known for 
short, occupies the entire screen 
although the tabs from the 
Ribbon still remain visible across 
the top. 

At the left of the Backstage is a 
navigation pane which is made up 
of Quick commands, smallish 
buttons that will perform an 
operation immediately, and 
largish tabs, which display more 
options and information to the 
right of the screen. 

The underlying purpose of the 
Backstage is to make it easier to 
manage your accounts and 
customise Outlook. 

Backstage Tabs 

The Backstage tabs provide more options for 
working with a document 

 

Lets you modify account 
settings, clean your mailbox, 
and create and manage rules 
and alerts 

 

Lets you open a previously 
saved calendar or data file, 
and import and export files 

 

Lets you preview and print the 
current Outlook item 

 

Provides access to Microsoft’s 
help network and also 
provides licensing information 
about your software 

 

Quick Commands 

The Quick commands provide immediate 
access to an operation. 

 

Allows you to save the current 
Outlook item under a different 
name or location 

 
Allows you to save all 
attachments in a selected email 
message 

 

Provides access to options that 
allow you to control how 
Outlook appears and works 

 

Allows you to close and exit 
Microsoft Outlook 
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